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INTRODUCTION

We're proud of what we do as the Global Commons 
Alliance, what we stand for and how we work together  
for people and the planet. 

But what we do is complex. So please take a few moments 
to read these pages on our brand narrative – they will  
help you understand what we want to say, and how we  
can explain it to others.
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BRAND STRATEGY 01
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THE PROBLEM Humanity is on a collision course  
with the carefully balanced natural 
systems that have kept our planet 
liveable for millennia.
We all depend on these ‘global commons’, the 
interconnected systems that support life on Earth: 
from the Arctic sea ice to the Amazon rainforest, 
from critical ocean currents to our fresh water 
network.

These are the critical functions that, working 
together, make our planet habitable. They keep our 
land fertile, our ocean healthy, our air clean and our 
climate stable. But now human actions are pushing 
them out of balance.

The global commons are our shared inheritance, 
and our shared responsibility. 

Yet our existing institutions and societies weren’t 
designed to tackle this kind of universal challenge – 
the scale is too vast and they aren’t offering joined-
up solutions. 

WHY IT MATTERS

WHAT WE'RE DOING

HOW WE DO IT

BRAND STRATEGY
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A series of tipping points are rapidly 
approaching.
What if we can’t learn to live within the boundaries 
that keep our planet safe? 

What if we can’t transform the way we do things, 
to ensure a decent life for everyone and to preserve 
what’s common to all?

Then we will have created an earth that’s less 
liveable, for all humans, and all species. We will 
have put everything we know in danger. 

We CAN solve this. But it means working together to 
make fundamental changes on a global level, from 
how we create energy to how we produce our food. 

It takes collective endeavour, and collective action, 
to ensure a safe and just future for people and 
planet. We need that action to include everyone – 
locally, nationally, internationally – and we need 
that action now.WHY IT MATTERS

WHAT WE'RE DOING

THE PROBLEM

HOW WE DO IT

BRAND STRATEGY
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No one citizen, company, city or 
country can solve this alone. So we 
have created a unique global alliance 
of those willing to park their egos, pool 
resources and work as one for  
the greater good.
Together, we’re turning theory into practice, despair 
into hope, and aspiration into action. We’re showing 
how everyone can become active guardians of the 
global commons we all share and depend on.

We seek out new ideas and spark collective action. 
We test and incubate innovative new approaches, 
models and products, at speed. 

We’re constantly convening, facilitating and 
questioning the status quo – a network of networks 
empowering each other and envisioning a time 
when we have moved safely to a rebalanced and 
restored planet.

WHAT WE'RE DOING

HOW WE DO IT

THE PROBLEM

WHY IT MATTERS

BRAND STRATEGY
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THE PROBLEM We are an alliance driving 
collaboration, innovation and funding, 
currently formed of 5 core components 
and over 70 partners. 
We come together from all over the world, bringing 
together rigorous science with diverse ideas, 
perspectives and solutions, in order to change 
mindsets, actions and systems.  

Our Earth Commission is pioneering a scientific 
framework defining the safe and just boundaries 
for a liveable planet, and our Science Based 
Targets Network translates this into clear goals for 
companies and cities.

Through our Earth HQ we communicate with 
the public, informing them about the issues and 
creating pressure for action. Our Systems Change 
Lab provides insights and tracks progress on the 
radical changes required, and our Accountability 
Accelerator designs and supports ways to hold 
companies accountable to their commitments.

Everything we do is co-created but retains a single-
minded focus – to enable all of us to safeguard the 
global commons.

WHY IT MATTERS

WHAT WE'RE DOING

HOW WE DO IT

BRAND STRATEGY
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BRAND NARRATIVECORE IDEA

Whoever we are, wherever we are, we 
all share something in common: the 
interconnected systems that maintain 
a stable and resilient planet – and keep 
us alive. 
We need these ‘global commons’ to keep our 
land fertile, our ocean healthy, our air clean and 
our climate stable. From the Arctic sea ice to the 
Amazon rainforest, from critical ocean currents to 
our fresh water network, they support the health 
– and life – of everything on Earth. But these life-
support systems are in danger of breaking down.

Safeguarding them requires a different kind of 
global effort, and a different kind of thinking. 

It requires humanity to work together to reimagine 
and transform how we live our lives, so all of us can 
thrive. 

We are a growing coalition of scientists, 
philanthropists, businesses and innovators, 
inspiring new ideas and action – an alliance of the 
willing, channelling the courage of the many, for the 
benefit of all.  

Our vision is a safe and just future for people 
and planet. Our mission is to mobilize citizens, 
companies, cities and countries to accelerate 
systems change, and become better guardians of the 
global commons.

WHAT’S 
COMMON 
TO ALL, 
ESSENTIAL 
TO ALL,  
IN NEED  
OF US ALL.
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Our values

Collaboration

Ingenuity

Impact

Courage

Hope

Credibility

Empowering

Inspiring

Human

Action-orientated

Approachable expert

Trustworthy

GCA partners

NGOs

Companies

Funders and 
philanthropists

Financial sector 
organisations

Policy makers

Media

Citizens

Change mindsets

Change actions

Change systems

Our personality Our key audiences Our strategic priorities

OUR VALUES AND PERSONALITY
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VISUAL IDENTITY02
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IDENTITY INTRODUCTION

A world that's teeming with life
We use photographic collage to portray 
a world that's teeming with life. Where 
people, animals, plants and natural 
phenomena are directly connected and 
all depend on each other.
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IDENTITY OVERVIEW

Collage logo Leaf logo

Iconography

Core colorsTypography

Collages Textures

ALMARAI IS  
OUR DISPLAY
TYPEFACE
Vollkorn is for body copy
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LOGOS 03
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OUR LOGO

Concept
Our logo encapsulates our brand concept: 
portraying an interconnected world that’s 
teeming with life.

Core collage logo
Our logo is composed of  an apricot leaf  
(portraying plants), a hummingbird 
(portraying animals), a snowflake 
(portraying climate) and our wordmark. 

The core logo is shown here. This is the 
version we most commonly use.
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LOGO COLORWAYS

Two Colorways
Two versions of  our collage logo will be 
available, one for light backgrounds and 
one for dark backgrounds. 

Positive collage logo Negative collage logo
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LOGO VARIATIONS Positive collage logo
Minimum width: 17mm/200px

Positive leaf logo
Minimum width: 10mm/118px

Small use logo 
10mm/118px and below

Negative collage logo

Negative leaf logo Small use logo

Collage logo
We use the collage logo most often. It is 
our most recognisable brand element.

Leaf logo 
The leaf  logo without the additional 
collage elements can be used for smaller 
use, or as an element to be used with 
other collages.

Small use logo 
The small use logo is a simplified version 
that exists only for use in small spaces 
where the details of  the leaf  logo and 
collage logo would be lost, such as 
favicons.
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To allow our logo to stand out do not place 
any designed objects such as illustrations 
or text in the clear space shown.

Clear space is calculated by measuring one 
sixth of  either logo's total width.

1/6 x 1/6 x 1/6 y 1/6 yx y

CLEAR SPACE

Collage logo Leaf logo
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ON SCREEN

On social media platforms like 
Facebook, X, Instagram and LinkedIn 
our leaf  logo is optically centred on an 
off-white circle.

Our website favicon uses the logo 
adjusted for small sizes. There are two 
files for light and dark modes. 

Social media symbol

Favicon

Global Commons Alliance 

  https://globalcommonsalliance.org/

19Global Commons Alliance Brand Guidelines October 2023   Version 01



CHOOSING A LOGO

TITLE TEXT

TITLE TEXT

Fig 1.
Our collage logo should be used wherever 
possible as our core, introductory brand 
element. It should however not sit 
alongside other collages to prevent a 
layout from looking too busy.

Fig 2.
The leaf  logo should be used when there 
are other collages in a layout. There should 
be only one core collage per layout to 
prevent repetition.

Fig 1.

Fig 2.
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CHOOSING A LOGO TITLE TEXT

TITLE TEXT

The collage logo should not sit alongside 
other collages within a single layout to 
prevent layouts from getting too busy.
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LOGO POSITION

Our design system is flexible and the 
placement of  our logo should be dictated 
by layout, legibility and imagery. 

As long as we observe the clear space rule, 
the logo can be placed in any corner, on 
either side ensuring it is clearly visible and 
legible. Collage logo elements can 

breach margins for the leaf  to 
sit closer to the margin edge
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LOGO EXCEPTIONS

In tight spaces where legibility may be 
hindered otherwise, the leaf  logo can be 
cropped. When cropping the logo,  
enough space should remain above and 
below the logotype that's equal to or more 
than the height of  the letters.

Page Highlight

See all employees in Linkedi n

All employees 

See all details

Research Services

About

Lorem ipsum dolor sit amet, consectetue r

Followers

Lorem ipsum dolor sit amet, consectetue r

Global Commons Alliance

The Global Commons Alliance (GCA) is a growing coalition of scientists, philanthropists, businesses and innovators, 
inspiring new ideas and action to safeguard what’s common and precious to us all: the global commons. 
Our mission is to mobilize citizens, companies, cities and countries to accelerate systems change, and become better 
guardians of the global commons.

What's common to us all?x

= x
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LOGO FILE TYPES

The Global Commons Alliance logos are 
comprised of  photographic elements 
and are not vector based. When creating 
designs for either screen or print, the 
correct file type should be used. 

Screen (RGB)
All leaf  logos and collage logos optimised for screen use have been saved 
in PNG format with transparent backgrounds. 

A high resolution and low resolution of  each logo has been created. The 
high resolution versions should be used wherever possible. They have 
been formatted with pixel widths of  up 7000px and should be scalable 
for use on any screen.

Low Resolution logos have been created with pixel widths of  1000-
2000px. They should only be used when the larger file sizes of  the high 
resolution logos are affecting performance

Print (CMYK) – up to 50cm width
For print, TIFF logos should be used where possible as this file type 
supports transparent backgrounds so the logos can be placed onto any 
color background.

Where TIF logos aren't supported, JPEG logos may be used. JPEGs do 
not have transparent backgrounds though and so must be placed onto 
backgrounds that match the background color.

XL Print (CMYK) – up to 10m width
For large format printing, such as exhibition stands, An 
extra large version off the Global Commons Alliance 
collage logo exists as a TIFF file.

PNG

GCA_Leaf_Logo_
Slate_RGB.png

PNG

GCA_Leaf_Logo_
Slate_RGB_LR.png

GCA_Logo_Leaf_
Slate_CMYK.tif

TIFF

GCA_Logo_Leaf_
Slate_XL_CMYK.tif

TIFF
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x ½ x ½ x

Partnership
We work with some fantastic 
organizations, but we all need our own 
space. As a general rule, we lead with our 
logo on the left and try to leave a space 
that's equal to half  the width of  our leaf  
logo between our logo and our partners.

The collage logo can be used in co-
branding line-ups when it is to be 
implemented >17mm wide.

The logo leaf  can be used in co-branding 
line-ups when it is to be implemented 
<17mm wide.

CO-BRANDING 

Minimum logo width: 17mm/65px
Minimum logo width: 10mm/38px
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PLEASE DON'T

Do not place the logo on 
complicated background 
imagery.

Do not change the color of  
logos.

Do not place the logo in a  
containing shape or box.

Do not distort the logo Do not change the add 
effects to the logo

Do not use the logotype 
in isolation

Do not place on an angle

Do not change the size, 
position or relationship of  
the symbol and logotype

Do not change the size, 
position or relationship of  
the symbol and logotype

Do not crop the logo

Do not re-create the 
logo in any way

Do not reposition 
the logotype
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COLORS04
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OUR COLOR PALETTE

Slate
Pantone: 2217u
R:0 G:60 B:70  
#003c46
C:100 M:45 Y:30 K:65

Off-white
R:248 G:245 B:235  
#f8f5eb
C:0 M:1 Y:14 K:0

Turquoise
Pantone: 3265u
R:75 G:192 B:173   
#4bc0ad
C:76 M:0 Y:46 K:0

Dark Turquoise*
Pantone: 3275u
R:0 G:159 B:143   
#009F8F
C:80 M:8 Y:50 K:0

Urgent Red
Pantone:
R:222 G:108 B:80   
#de6c50
C:0 M:70 Y:70 K:0

Bold Blue
Pantone: 7461u
R:41 G:143 B:172   
#298fac
C:82 M:25 Y:0 K:0

Our colors are inspired by nature. We 
mainly use our slate, off-white and 
turquoise colors, reserving urgent red 
and bold blue for accents.

*A dark versions of  Turquoise exists for 
when typography is combined with the 
off-white to create accessible and user-
friendly color contrast combinations. 
Guidance can be found on page here.
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25% 25% 25% 25% 

50% 50% 50% 50% 

75% 75% 75% 75% 

100% 100% 100% 100% 

COLOR TINTS

Tints of  any of  the core brand colors can 
be used in graphs and Infographics. See 
here for examples.

#f7dad3 

#eeb6a8 

#e6917c 

#de6c50 

#c9e3ea

#94c7d5

#5fabc1

#298fac

#d2efeb 

#a5dfd6 

#78d0c2 

#4bc0ad 

#bfced1 

#809ea2 

#406d74 

#003c46 
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TYPOGRAPHY 05
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BRAND TYPEFACES

EXRABOLD
Regular

Regular
Italic
Bold
Bold Italic

Almarai

Vollkorn

Almarai
Headlines should be set in Almarai 
Extrabold and are always capitalised.

Almarai Extrabold and Regular can also 
be used for diagrams and captions in 
sentence case but never for body copy.

Almarai is a Google Font and can be 
downloaded here.

Vollkorn
Vollkorn is our body copy font. Vollkorn 
is a Google Font and can be downloaded 
here.

if  you're creating a new branded document 
in Google docs Connect fonts extension

ABCDEFGHIJKLMNOPQSTUVWXYZ

?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ

abcdefghijklmnopqstuvwxyz?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ
abcdefghijklmnopqstuvwxyz
0123456789?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ
abcdefghijklmnopqstuvwxyz
0123456789?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ
abcdefghijklmnopqstuvwxyz
0123456789?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ
abcdefghijklmnopqstuvwxyz
0123456789?!@<>+-=( )
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JOIN  
THE 
GLOBAL 
ALLIANCE 
TO 
PROTECT 
THE 
GLOBAL 
COMMONS.

We all own them.

LET'S START 
INVESTING 
IN THEM.

To shape a nation,  
you need a government. 

TO SHAPE  
A PLANET,
YOU NEED AN 
ALLIANCE.

WHOEVER  
WE ARE  
WHEREVER  
WE ARE we all share  

something  
in common.

TYPEFACE 
EXAMPLES
Our headline and body copy typeface 
should be combined with plenty of  
contrast between them.

32



ARE 
WILLING  
TO DO  
MORE

STEWARDSHIP
INDEX 2023

Headline typeface

USING OUR TYPEFACES

73Numerals
Even in headlines, the Almarai numerals 
should not be used. Vollkorn Regular 
should be used instead.

Font sizes may need to be adjusted for the 
two typefaces to feel balanced and the 
height of  the capitals to match.
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Headline typeface

USING OUR TYPEFACES

Diagrams and captions
Almarai Extrabold and Regular can be 
used in either all caps or sentence case for 
captions and within diagrams.

“Addressing them 
effectively—and 
with the necessary 
urgency—requires 
unprecedented 
cooperation.”
Dominic Waughray 
Advisor to the CEO, WBCSD – 
Former Chair of  the GCA
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2

1

3

4

5

THE GLOBAL 
COMMONS
VITAL FOR  
ALL LIFE

OUR VISION IS A SAFE 
AND JUST FUTURE FOR 
PEOPLE AND PLANET.
Humanity is on a collision course with the 
carefully balanced natural systems that have 
kept our planet liveable for millennia. We 
all depend on these ‘global commons’, the 
interconnected systems that support life on 
Earth: from the Arctic sea ice to the Amazon 
rainforest, from critical ocean currents to our 
fresh water network.

Safeguarding the global commons  
requires a different kind of global effort

“Addressing them 
effectively—and 
with the necessary 
urgency—requires 
unprecedented 
cooperation.”
Dominic Waughray 
Advisor to the CEO, WBCSD – 
Former Chair of  the GCA

 

We can use the following steps as a 
guide for type hierarchy. While display 
headlines can have a more flexible 
approach, this structure can be used 
design longer form documents. 

1. Page title
Headings are set in set in Almarai 
Extrabold in all caps. 
Leading: 85% (80pt/68pt)  
Case: Capitalised  Tracking: –10

2. Standfirst
Use Vollkorn Regular. 
Leading: 120% (36pt/43pt)  
Case: Sentence/Capitalised   
Tracking: –20

3. Paragraph heading
Use Almarai Extrabold for paragraph 
headings and button styles. 
Leading: 100% (30pt/30pt)  
Case: Capitalised  Tracking: –10

4. Body copy
Vollkorn Regular is used as the body copy 
typeface. Use a heavier weight if  on a 
colored background for legibility.

Leading: 140% (20pt/28pt)  
Case: Sentence  Tracking: 0

5. Quotes
Vollkorn Italic can be used to for quotes or 
large statements.  
Leading: 120% (36pt/43pt)  
Case: Sentence  Tracking: –20

6. Accreditations & captions
Almarai Extrabold and Regular weights can 
be used in sentence case with Vollkorn for 
captions only. 
Leading: 120% (36pt/43pt)  
Case: Sentence  Tracking: –20

FONT HIERARCHY
(Adobe software)

6

35Global Commons Alliance Brand Guidelines October 2023   Version 01



THE GLOBAL 
COMMONS
VITAL FOR  
ALL LIFE

OUR VISION IS A SAFE 
AND JUST FUTURE FOR 
PEOPLE AND PLANET.
Humanity is on a collision course with the 
carefully balanced natural systems that have 
kept our planet liveable for millennia. We 
all depend on these ‘global commons’, the 
interconnected systems that support life on 
Earth: from the Arctic sea ice to the Amazon 
rainforest, from critical ocean currents to our 
fresh water network.

Safeguarding the global commons  
requires a different kind of global effort

FONT HIERARCHY
(Google docs)
We can use the following steps as a 
guide for type hierarchy. While display 
headlines can have a more flexible 
approach, this structure can be used 
design longer form documents. 

1. Page title
Headings are set in set in Almarai 
Extrabold in all caps. 
Line spacing: 0.8 (custom) 
Case: Capitalised  

2. Standfirst
Use Vollkorn Regular. 
Line spacing: 0.8 (custom) 
Case: Sentence/Capitalised   

3. Paragraph heading
Use Almarai Extrabold for paragraph 
headings and button styles. 
Line spacing: 0.8 (custom) 
Case: Capitalised 

 

4. Body copy
Vollkorn Regular is used as the body copy 
typeface. Use a heavier weight if  on a 
colored background for legibility. 
Line spacing: 1.08 (custom) 
Case: Sentence  

5. Quotes
Vollkorn Italic can be used to for quotes or 
large statements.  
Line spacing: Single 
Case: Sentence 

6. Accreditations & captions
Almarai Extrabold and Regular weights can 
be used in sentence case with Vollkorn for 
captions only. 
Line spacing: 1.08 (custom) 
Case: Sentence  

“Addressing them 
effectively—and 
with the necessary 
urgency—requires 
unprecedented 
cooperation.”
Dominic Waughray 
Advisor to the CEO, WBCSD – 
Former Chair of  the GCA

 6

2

1

3

4

5
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USING BRAND FONTS IN GOOGLE DOCS

If  you're creating a new branded document 
in Google docs, the Extensis Fonts must 
be installed in order to access the headline 
font, Almarai.

To enable the Fonts Add-on:

1.  Open any Google Document, or  
create a new one.

2.  From the Add-ons menu, click  
Get Add-ons

3.  In the Search Add-ons box,  
enter "Extensis Fonts"

4.  Select the Extensis Fonts add-on  
from the list.

5.  Click the Install button in the  
upper right hand corner.

6.  Click Accept to install the add-on  
to your Google Docs account.
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IN OTHER SOFTWARE

BLACK 
Regular

Regular
Regular
Regular
Regular

Arial

Georgia

If  Almarai and Vollkorn are not available 
in the software you're using, you can use 
Arial and Georgia instead. ABCDEFGHIJKLMNOPQSTUVWXYZ 

?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ 
abcdefghijklmnopqstuvwxyz?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ 
abcdefghijklmnopqstuvwxyz 
0123456789?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ 
abcdefghijklmnopqstuvwxyz 
0123456789?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ 
abcdefghijklmnopqstuvwxyz 
0123456789?!@<>+-=( )

ABCDEFGHIJKLMNOPQSTUVWXYZ 
abcdefghijklmnopqstuvwxyz 
0123456789?!@<>+-=( )
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Our Vision is a safe 
and just future for 
people and planet

ABCDEFG

Our Vision is a safe 
and just future for 
people and planet

ABCDEFG

A SAFE AND 
JUST FUTURE

A SAFE AND 
JUST FUTURE

A SAFE AND 
JUST FUTURE

For people  
and planet.

99.99%

For people  
and planet.

For people  
and planet.

99.99% 99.99%

Our Vision is a safe 
and just future for 
people and planet

ABCDEFG

Our Vision is a safe 
and just future for 
people and planet

ABCDEFG

Small text and large text

Large text only

ACCESSIBILITY

This page provides reference and guidance 
for creating accessible and user-friendly 
designs. Text should have sufficient 
contrast with its background to be easily 
readable. 

WCAG 2.0 level AA requires a contrast 
ratio of  at least 4.5:1 for normal text and 
3:1 for large text.

Large text is defined as 14 point (typically 
18.66px) and bold or larger, or 18 point 
(typically 24px) or larger and regular.

Small text is defined as less than 14 point 
(typically 18.66px) and bold, or less than 18 
point (typically 24px) and regular.

If  a color combination is not shown here 
please avoid using it.

39Global Commons Alliance Brand Guidelines October 2023   Version 01



COLLAGES06
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The purpose of  the collages is to illustrate 
how life and nature are connected in 
unexpected ways. To feel unexpected the 
collages do the following:

1.  Collages should bring together elements 
that aren't typically seen together e.g. a 
person swimming with birds.

2.  Collages should play with scale, and 
defy the real life proportions of  objects 
in relation to each other.

COLLAGES
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GCA Globe Bitmap Positive Turquoise.png GCA Globe Bitmap Positive Slate.png

GCA Globe Bitmap Negative Turquoise.png GCA Globe Bitmap Negative Off White.pngCOLLAGE ELEMENTS

Rationale
The collages are illustrative compositions 
of  photographs and icons that  portray a 
world teeming with life.

Colorways
Collage elements will be provided in slate, 
off-white and turquoise. 

Negative collage elements
Are made to  be placed on on dark 
backgrounds.

Positive collage elements
Are made to  be placed on on light  colored 
backgrounds.

N
egative collage elem

ents
Positive collage elem

ents
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MAKING POSITIVE COLLAGE ELEMENTS 
(Positive collage elements can be placed on to lighter colored backgrounds)   

Choose a photograph
Photographs may be commissioned 
or downloaded from stock libraries.
Images should be high resolution 
and scaled to 7000 pixels wide at 
300 pixels/inch.

1. 3. 5.2. 4. 6.

Replace the background
The collage subject should be 
isolated either in Photoshop or with 
the assistance of  a service such as 
Pathedits.
Positive collage elements should be 
placed onto white backgrounds.

Convert to grayscale and  
increase the contrast
To convert an image to Grayscale, 
select it from the Image > Mode 
menu. Click "Merge" when 
Photoshop asks if  you want to 
discard the color information.
Increase the contrast using the 
Levels tool (Image > Adjustments > 
Levels).

Convert to Bitmap then  
RGB/CMYK
To convert an image to Bitmap, 
select it from the Image > Mode 
menu. Set the resolution output to 
the same value as the input. The 
image should then be converted 
back to RGB if  you are creating 
a collage element for screen or 
CMYK if  for print. You do this 
by going back to Image > Mode 
> greyscale then again Image > 
Mode > RGB or CMYK.

Remove white
Unlock the image layer by clicking 
on the lock icon. Then Select the 
background using the Color Range 
tool (Select > Color range). Click the 
dominant Then delete the selection.

Recolor with gradient maps
Add a color overlay (Layer > Layer 
Style > Color Overlay). Ensure the 
Blend Mode is set to Normal and the 
Opacity is 100%. Apply the desired  
color from the brand color palette.
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MAKING NEGATIVE COLLAGE ELEMENTS 
(Positive collage elements can be placed on to darker colored backgrounds)

Choose a photograph
Photographs may be commissioned 
or downloaded from stock libraries.
Images should be high resolution 
and scaled to 7000 pixels wide at 
300 pixels/inch.

1. 3. 5.2. 4. 6.

Replace the background
The collage subject should be 
isolated either in Photoshop or with 
the assistance of  a service such as 
Pathedits.
Negative collage elements should be 
placed onto black backgrounds.

Convert to grayscale and  
increase the contrast
To convert an image to Grayscale, 
select it from the Image > Mode 
menu. Click "Merge" when 
Photoshop asks if  you want to 
discard the color information.
Increase the contrast using the 
Levels tool (Image > Adjustments > 
Levels).

Convert to Bitmap then  
RGB/CMYK
To convert an image to Bitmap, 
select it from the Image > Mode 
menu. Set the resolution output to 
the same value as the input. The 
image should then be converted 
back to RGB if  you are creating 
a collage element for screen or 
CMYK if  for print. You do this 
by going back to Image > Mode 
> greyscale then again Image > 
Mode > RGB or CMYK.

Remove black
Unlock the image layer by clicking 
on the lock icon. Select the all black 
color using the Color Range tool 
(Select > Color range). Then delete 
the selection. This will leave only  
the white.

Recolor with gradient maps
Add a color overlay (Layer > Layer 
Style > Color Overlay). Ensure the 
Blend Mode is set to Normal and the 
Opacity is 100%. Apply the desired 
color from the brand color palette. 
The element will look unusual until 
placed onto a dark background.
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COLLAGE ELEMENT EXAMPLES
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SIMPLE COLLAGES

Simple collages bring together two or 
three collage elements and are ideal for 
use in layouts that also contain text and 
other elements.

They can function as illustrations to 
accompany a body of  text that may talk 
about the relationship between two things 
(people and insects).

Collages look best with a lead element, 
accompanied by a smaller element in a 
different color.
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SIMPLE COLLAGES
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SIMPLE COLLAGES
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LARGE COLLAGES Large collages bring together 5-10 collage elements.  Large 
collages should be built around a centrepiece element, 
with accompanying element greatly ranging in scale
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Collages can be built around the leaf  logo 
but the compositions should be carefully 
considered. Collage elements should in no 
way overpower the leaf  logo but should 
be secondary elements. They should 
not surround the logo, but be placed at 
opposite ends with a straight line drawn 
between them.

These collages should not replace our 
core collage logo but be considered as 
more decorative elements in relevant 
applications.

Collage element

Collage element

LEAF LOGO COLLAGES
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Collage elements should be printed at 
300dpi  minimum in print or displayed at 
72dpi minimum on screen.

If  a collage is needed at a larger size, for 
an exhibition stand for example, collage 
elements should be resized using the 
‘Image Size’ tool in Photoshop. 

When using the Image Size tool, the 
‘Resample’ menu should be set to ‘Nearest 
Neighbor (hard edges)’. This will keep the 
edges of  the elements crisp and prevent 
blurring.

RESIZING COLLAGE ELEMENTS
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NIGEL TOPPING

ABRUPT THAWDIE OFF
Boreal PermafrostCoral Reefs

Uk Climate Action Champion

Typography can be placed in boxes

 and combined with collage elements 
for use as video and film graphics and 
captions. 

TYPOGRAPHY AND COLLAGES
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Collage elements can be expanded and 
cropped onto coloured backgrounds to 
create graphic borders and textures when 
desired.

PHOTOGRAPHIC TEXTURES
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PHOTOGRAPHY06
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TREATING PHOTOGRAPHY

To make photography feel branded, duo 
tones can be applied using our brand 
colours. Treated photography should be 
used wherever possible in key branded 
channels such as social media and our 
website home page.
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CAPTIONING AND CREDITING

A caption is a description of  what the 
photograph shows that helps to explain its 
relevance to the reader. 

A credit is information about who took 
the photograph and owns the copyright. 
The latter is often requested by the 
photographer and is their legal right in 
most countries.

Captions normally sit below or nearby an 
image, whereas we place credits vertically 
up the inside or outside of  the photograph 
(depending on legibility).

A resident slowly makes his way through the inundated 
streets of  the village due to rising sea levels. 

©
 A

ji 
St

ya
w

an

We format credits as follows:

Photo: Photographer name/ copyright 
owner

or

© Photographer name/copyright Owner

Sometimes a photographer will ask to 
be credited in a different way – we try to 
respect their wishes where possible. If  
there are multiple images in a layout it is 
acceptable to place all the credits together, 
either running vertically up the side of  the 
page or at the end of  a document.

When using images in digital 
communications ensure that ‘alt’ text 
is added so that audiences using screen 
readers don’t miss out on content.

https://climatevisuals.org/asset/836/

56Global Commons Alliance Brand Guidelines October 2023   Version 01



ICONS07
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Renewable power Cycles Global connectivity Global network Earth Urban network Natural network

Data Temperature Connectivity Protect Systems System workingm Hive

Broadcast Accost Boundaries Exchange Time Currency Conversations

ICON SUITE
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ICON USE

WHOEVER  
WE ARE,  
WHEREVER  
WE ARE
We all share something  
in common

What’s common to all, 
essential to all, in need of  us all

We all own them.

LET’S 
START 
INVESTING 
IN THEM.

Icons can be used as graphic, illustrative 
devices supporting or visualising a written 
message. Icons may be used in such a way 
when there is no room for a collage, or if  
a collage is serving a different purpose, 
elsewhere within a layout.

Icons can also be used within collages to 
illustrate more abstract ideas that can't be 
portrayed with photography
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INFOGRAPHICS08
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SIMPLE INFOGRAPHICS

Lorum ipsum421

421

421

421

421

421

421

421

421

421

62%

20%

8%

2%

 6-7 Transformations
 4-5 Transformations
 1-3 Transformations
 No Transformations

2019

2020

2021

2022

2023

0 200 400100 300 500

82%
Graphs and infographics should be 
simple but bold, prioritising clarity and 
readability. 

The colors from our palette that can be 
used as tints for infographics are shown 
here.

5.1

G20: Actions supporting transformation

13.6

23.2

10.6
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PHOTOGRAPHIC INFOGRAPHICS

Number of areas aware 
that scientists agree 
transformation is needed

6-7 transformations

4-5 transformations

1-3 transformations

No transformations

G20: IMPORTANT QUALITIES  
TO TEACH CHILDREN

+0.89°C

Tolerance  
& respect  
for others

Good 
manners

Feeling of 
responsibility

Hard work

Independence

Perseverance

Protection  
of nature

63%

59%

57%

36%

34%

34%

34%

2019 2020 2021 2022 2023

G20: ACTIONS SUPPORTING 
TRANSFORMATION

Graphs and Graphics can accompany 
relevant collage imagery to make 
infographics more engaging.
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LAYOUT09
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LOGO SIZE

TITLE TEXT TITLE TEXT TITLE TEXT TITLE TEXT

Our logo is bold and expressive and can fill 
a document's margins. It is also important 
however for there to be plenty of  contrast 
in size between our logos and typography 
in order to create a sense of  scale.

Logos can be scaled down to occupy half, a 
third or a sixth of  a document's  available 
design space in order to accommodate a 
desired typography style.

This applies to all logos.

Collage logo elements can breach 
margins for the leaf  to sit closer 
to the margin edge
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LAYOUT FUNDAMENTALS

Where our collages are loose and 
expressive, our typography and 
photography is gridded and organized.

In order to accommodate the variety of  
content we product, the approach to layout 
is quite flexible and modular.

Despite this flexibility, layouts should 
be approached with simplicity in mind. 
Variations in typographic styles and 
should be kept to a minimum.

Printed pages should be divided into rows 
and columns of  2, 3, 6, 8 or 12. It is good 
practice to create a document grid with 
as few cells as possible. This prevents too 
much variation within a layout.

A GROWING 
CHALLENGE

01
Giam siti cum qui cusae nusdae vella 
veruptatetur aliquiam, consequ iscipiendit 
voluptis ma quatia vernam fugitibus aut a 
consero eos sunt quoditae veraerio. Necest 
endit et aut ulpari qui quibusam, optatis 
aboratur acculli aspiet peruptatus.
Onsequis autectestiam debit ut volore nam fuga. Itae volor a vitaspeliqui nus, 
con repudae dioribusa non nobis ma volumqui dera nissecuscid quae velenis 
ab ipsam et, se prempernam facimil ipit periber iberrum dem fuga. Uciet 
pra esto volupta eremporum doluptati odignatur arum quo quibusc iissime 
plabor molorent, sit es am et que provit explab ilia volupisit que perunt et 
eum faceper escietum quam, estisquae est, aut aut volorru mquiasp erferit 
lacestiatus renit, quam, vente idionse quaerem recerepre, inusant quo mo 
vel ium vendus quissed maiorpor autem atenihiciam consequo maximeniae 
enisquibus invelles dolorempore ipsam sa doluptiatur?

Ecerae. Et incit, etum eos everia et, unt mos aut aliscil ipidi ut mod eos 
eos dersperum, sit pre samus porem hiciet qui temporit parcias imintib 
erchitium accae modigen duciend anderis earum anderibus arum sedit 

Image caption (right)
Xeratur magnatum reperem. 
Nossit que milibus mi, quis 
mi, nimus doloria et alit esci-
enit es debis iunto imagnis-
que velictem hillabo repudi-
orum quam apernam, cor as 
corenestem. Natur minctatur.

23 Global Commons Alliance Impact Statement

BREAKING SILOS
The world is facing a paradigm and systems 
shift  that challenges business as usual and 
calls for new and radical collaboration. Global 
Commons Alliance recently joined the Capitals 
Coalition’s community of business, fi nance and 
civil society leaders in Paris to plan the critical 
steps that will get us there – for a safe, just 
future that values nature and people fi rst.

01 Introduction

02  The Scope of this 
Navigator 

03  How to Engage with This 
Navigator

04  Mapping Nature-related 
Global Frameworks, 
Standards, Methodologies, 
and Decision-making 
Tools

05  Mapping Climate-related 
Global Frameworks, 
Standards, Methodologies, 
and Decision-making Tools

06  The User Journey 
Introduction

07  User Journey Management 
Resources

08  Summaries of High Impact 
Resources, Frameworks, and 
Methodologies to Manage for 
Nature

Giam siti cum qui cusae nusdae vella 
veruptatetur aliquiam, consequ iscipiendit 
voluptis ma quatia vernam fugitibus aut a 
consero eos sunt quoditae veraerio. Necest 
endit et aut ulpari qui quibusam, optatis 
aboratur acculli aspiet peruptatus.
Onsequis autectestiam debit ut volore nam fuga. Itae volor a vitaspeliqui nus, con 
repudae dioribusa non nobis ma volumqui dera nissecuscid quae velenis ab ipsam 
et, se prempernam facimil ipit periber iberrum dem fuga. Uciet pra esto volupta 
eremporum doluptati odignatur arum quo quibusc iissime plabor molorent, 
sit es am et que provit explab ilia volupisit que perunt et eum faceper escietum 
quam, estisquae est, aut aut volorru mquiasp erferit lacestiatus renit, quam, vente 
idionse quaerem recerepre, inusant quo mo vel ium vendus quissed maiorpor 
autem atenihiciam consequo maximeniae enisquibus invelles dolorempore ipsam 
sa doluptiatur?

Ecerae. Et incit, etum eos everia et, unt mos aut aliscil ipidi ut mod eos eos 
dersperum, sit pre samus porem hiciet qui temporit parcias imintib erchitium 
accae modigen duciend anderis earum anderibus arum sedit eos minullest, 
offi  cimil et fuga. Otas di dolorpori odit quae. Aborro to est, con nitet aut 
laboribusa arumquae audanda doluptatem eos iuntibus idel intoribus simporem 
consequi aut quo quam qui verum sinctam non poriand aesciisquam, sitasped 
maxim as vendignam, volecea es etus, sunt perro moluptature, sitaque plique quis 
sus et laccatus, ex et offi  ci repedigenim cuptatus ad magnienit ratae cus nonsequ 
iatquunt ipsant fugiaeriores moluptis et ex et ut dem ipsum in re, que suntius re 

24 Global Commons Alliance Impact Statement
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PAPER AND PRINTING10
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PAPER AND PRINTING
We hold a deep commitment to environmental responsibility.  
We firmly believe in only putting ink to paper when it is  
absolutely necessary. 

Choose materials that minimize our ecological footprint and 
prioritise the use of sustainable and recyclable paper and materials 
and use printing companies with environmental credentials. 

Printed materials may also include a printed reminder for the end 
user to re-use or recycle the item.
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 COMPONENT 
LOGOS & BRAND 
ARCHITECTURE 

11
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COMPONENT IDENTITY: INTRODUCTION

Component logos
Each component of  the Global Commons 
Alliance has its own leaf  logo, leaf  
collage and color palette. This gives each 
component its own distinct set of  tools 
for communication and brand expression 
while being in line with the Global 
Commons Alliance brand style.
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Collage logo

Leaf logo with endorsement
Minimum width: 40mm/151px

Leaf logo
Minimum width: 18mm/68px

Small use leaf logo with endorsement 
Minimum width: 30mm/113px

SYSTEMS CHANGE LAB: POSITIVE LOGOS

The Systems Change Lab collage logo 
consists of  a Wild Cherry leaf, a wind 
farm, an owl and a connected earth 
diagram.

The collage logo and leaf  logo usage rules 
follow the Global Commons Alliance logo 
rules found here.

When the logos are being used within any 
Global Commons Alliance channels (such 
as the Global Commons Alliance website), 
logos without endorsements can be used. 
Logos with endorsements should be used 
when implemented anywhere else.

The small use leaf  logo with endorsement 
should be used as an alternative to the leaf  
logo with endorsement at sizes lower than 
40mm/151px.
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SYSTEMS CHANGE LAB: NEGATIVE LOGOS

Collage logo

Leaf logo with endorsement
Minimum width: 40mm/151px

Leaf logo
Minimum width: 18mm/68px

Small use leaf logo with endorsement
Minimum width: 30mm/113px

The colors in our negative logos have been 
inversed so they stand out against dark 
backgrounds. In all other ways the same 
rules apply as on the previous page.
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Slate and Off-white 
are an accessible 
combination for small 
text and large text.

Slate and SCL Purple 
are an accessible 
combination for small 
text and large text.

Slate and SCL Purple 
are an accessible 
combination for small 
text and large text.

Slate and Off-white 
are an accessible 
combination for small 
text and large text.

Slate
Pantone: 2217u 
R:0 G:60 B:70   
#003c46 
C:100 M:45 Y:30 K:65

Off-white
R:248 G:245 B:235   
#f8f5eb 
C:0 M:1 Y:14 K:0

SCL Purple
R:248 G:245 B:235  
#bf8fb2 
C:30 M:50 Y:10 K:0

SCL Dark Purple
R:248 G:245 B:235  
#925d89 
C:50 M:70 Y:20 K:5

Component colors
Each component uses the Global 
Commons Alliance slate and off-white as 
core typography and background colors 
with an additional component color for 
use with typography and collages.

Tints of  the component color can be 
used in charts and infographics. A dark 
version of  each component color exists for 
accessible display typography.

Typography color rules
Refer to these typography color 
combinations for creating accessible and 
user-friendly designs. Text should have 
sufficient contrast with its background to 
be easily readable. 

Large text is defined as 14 point (typically 
18.66px) and bold or larger, or 18 point 
(typically 24px) or larger and regular.

Small text is defined as less than 14 point 
(typically 18.66px) and bold, or less than 18 
point (typically 24px) and regular.

If  a color combination is not shown here 
please avoid using it.

SYSTEMS CHANGE LAB: COLORS

OFF-WHITE 
ON DARK SCL 
PURPLE

SLATE  
ON SCL 
PURPLE

DARK SCL 
PURPLE ON 
OFF-WHITE

SCL PURPLE 
ON SLATE

Accessible typography color combination for large text Accessible typography color combination for small and large text

80% 
#cca6c1 

60%
#d8bcd1

40%
#e5d3e0 

20%
#f2e9f0 
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SYSTEMS CHANGE LAB: COLLAGE ELEMENTS

A suite of  collage elements have been 
selected for each component. Positive and 
negative versions of  each element have 
been created in slate, off-white and the 
colour of  that component.

Additional collage elements can be made 
by following this guide here. Additionally, 
existing elements from other components 
or the Global Commons Alliance suite can 
be recoloured accordingly.
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Collage logo

EARTH COMMISSION: POSITIVE LOGOS

Leaf logo with endorsement
Minimum width: 50mm/188px

Leaf logo Small use leaf logo with endorsement 
Minimum width: 28mm/105px

The Earth Commission collage logo 
consists of  an avocado leaf, an olive tree, a 
bee, a hand print and the earth.

The collage logo and leaf  logo usage rules 
follow the Global Commons Alliance logo 
rules found here.

When the logos are being used within any 
Global Commons Alliance channels (such 
as the Global Commons Alliance website), 
logos without endorsements can be used. 
Logos with endorsements should be used 
when implemented anywhere else.

The Small use leaf  logo with endorsement 
should be used as an alternative to the leaf  
logo with endorsement at smaller sizes.
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EARTH COMMISSION: NEGATIVE LOGOS

Collage logo

Leaf logo with endorsementLeaf logo Small use leaf logo with endorsement

The colors in our negative logos have been 
inversed so they stand out against dark 
backgrounds. In all other ways the same 
rules apply as on the previous page.
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EC Blue
R:0 G:168 B:240  
#00a8f0
C:80 M:16 Y:0 K:0

EARTH COMMISSION: COLORS

Slate and Off-white 
are an accessible 
combination for small 
text and large text.

Slate and EC Blue are 
an accessible 
combination for small 
text and large text.

Slate and EC Blue are 
an accessible 
combination for small 
text and large text.

Slate and Off-white 
are an accessible 
combination for small 
text and large text.

EC Dark Blue
R:0 G:150 B:214  
#0096d6 
C:89 M:25 Y:0 K:0

OFF-WHITE ON 
DARK EC BLUE

SLATE ON  
EC BLUE

DARK EC BLUE  
ON OFF-WHITE

EC BLUE ON 
SLATE

Accessible typography color combination for large text Accessible typography color combination for small and large text

Component colors
Each component uses the Global 
Commons Alliance slate and off-white as 
core typography and background colors 
with an additional component color for 
use with typography and collages.

Tints of  the component color can be 
used in charts and infographics. A dark 
version of  each component color exists for 
accessible display typography.

Typography color rules
Refer to these typography color 
combinations for creating accessible and 
user-friendly designs. Text should have 
sufficient contrast with its background to 
be easily readable. 

Large text is defined as 14 point (typically 
18.66px) and bold or larger, or 18 point 
(typically 24px) or larger and regular.

Small text is defined as less than 14 point 
(typically 18.66px) and bold, or less than 18 
point (typically 24px) and regular.

If  a color combination is not shown here 
please avoid using it.

Slate
Pantone: 2217u 
R:0 G:60 B:70   
#003c46 
C:100 M:45 Y:30 K:65

Off-white
R:248 G:245 B:235   
#f8f5eb 
C:0 M:1 Y:14 K:0

80% 
#33b9f3 

60%
#66cbf6

40%
#99dcf9 

20%
#cceefc 
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EARTH COMMISSION: COLLAGE ELEMENTS

A suite of  collage elements have been 
selected for each component. Positive and 
negative versions of  each element have 
been created in slate, off-white and the 
colour of  that component.

Additional collage elements can be made 
by following this guide here. Additionally, 
existing elements from other components 
or the Global Commons Alliance suite can 
be recoloured accordingly.

Final image choice pending

77Global Commons Alliance Brand Guidelines October 2023   Version 01



Collage logo

ACCOUNTABILITY ACCELERATOR: POSITIVE LOGOS

Leaf logo with endorsement
Minimum width: 60mm/225px

Leaf logo Small use leaf logo with endorsement 
Minimum width: 39mm/147px

The Accountability Accelerator collage 
logo consists of  a willow leaf, a butterfly, 
scales of  justice and a connected humanity 
diagram.

The collage logo and leaf  logo usage rules 
follow the Global Commons Alliance logo 
rules found here.

When the logos are being used within any 
Global Commons Alliance channels (such 
as the Global Commons Alliance website), 
logos without endorsements can be used. 
Logos with endorsements should be used 
when implemented anywhere else.

The Small use leaf  logo with endorsement 
should be used as an alternative to the leaf  
logo with endorsement at smaller sizes.
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ACCOUNTABILITY ACCELERATOR: NEGATIVE LOGOS

Collage logo

Leaf logo with endorsement Leaf logo Small use leaf logo with endorsement

The colors in our negative logos have been 
inversed so they stand out against dark 
backgrounds. In all other ways the same 
rules apply as on the previous page.
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AA Green
R:141 G:196 B:66 
#8dc442 
C:55 M:0 Y:97 K:0

Slate and Off-white 
are an accessible 
combination for small 
text and large text.

Slate and AA Green 
are an accessible 
combination for small 
text and large text.

Slate and AA Green 
are an accessible 
combination for small 
text and large text.

Slate and Off-white 
are an accessible 
combination for small 
text and large text.

Dark AA Green
R:90 G:146 B:50  
#5a9232 
C:74 M:24 Y:100 K:0

DARK AA 
GREEN ON OFF-
WHITE

SLATE ON AA 
GREEN

OFF-WHITE 
ON DARK AA 
GREEN

GREEN ON 
SLATE

Accessible typography color combination for large text Accessible typography color combination for small and large text

Component colors
Each component uses the Global 
Commons Alliance slate and off-white as 
core typography and background colors 
with an additional component color for 
use with typography and collages.

Tints of  the component color can be 
used in charts and infographics. A dark 
version of  each component color exists for 
accessible display typography.

Typography color rules
Refer to these typography color 
combinations for creating accessible and 
user-friendly designs. Text should have 
sufficient contrast with its background to 
be easily readable. 

Large text is defined as 14 point (typically 
18.66px) and bold or larger, or 18 point 
(typically 24px) or larger and regular.

Small text is defined as less than 14 point 
(typically 18.66px) and bold, or less than 18 
point (typically 24px) and regular.

If  a color combination is not shown here 
please avoid using it.

ACCOUNTABILITY ACCELERATOR: COLORS

Slate
Pantone: 2217u 
R:0 G:60 B:70   
#003c46 
C:100 M:45 Y:30 K:65

Off-white
R:248 G:245 B:235   
#f8f5eb 
C:0 M:1 Y:14 K:0

80% 
#a4d068 

60%
#bbdc8e

40%
#d1e7b4 

20%
#e8f3d9 
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ACCOUNTABILITY ACCELERATOR: COLLAGE ELEMENTS

A suite of  collage elements have been 
selected for each component. Positive and 
negative versions of  each element have 
been created in slate, off-white and the 
colour of  that component.

Additional collage elements can be made 
by following this guide here. Additionally, 
existing elements from other components 
or the Global Commons Alliance suite can 
be recoloured accordingly.
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Collage logo

SCIENCE BASED TARGETS NETWORK: POSITIVE LOGOS

Leaf logo with endorsement
Minimum width: 44mm/166px

Leaf logo

Small use leaf logo with endorsement 
Minimum width: 30mm/113px

The Accountability Accelerator collage 
logo consists of  Maple-Leaf Oak leaf, 
a hummingbird, a school of  Southern 
bluefin tuna, a hand print and the earth.

The collage logo and leaf  logo usage rules 
follow the Global Commons Alliance logo 
rules found here.

When the logos are being used within any 
Global Commons Alliance channels (such 
as the Global Commons Alliance website), 
logos without endorsements can be used. 
Logos with endorsements should be used 
when implemented anywhere else.

The Small use leaf  logo with endorsement 
should be used as an alternative to the leaf  
logo with endorsement at smaller sizes.
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Collage logo Leaf logo with endorsement

Leaf logo

Small use leaf logo with endorsement

SCIENCE BASED TARGETS NETWORK: NEGATIVE LOGOS

The colors in our negative logos have been 
inversed so they stand out against dark 
backgrounds. In all other ways the same 
rules apply as on the previous page.
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Slate and Off-white 
are an accessible 
combination for small 
text and large text.

Slate and SBTN Yellow 
are an accessible 
combination for small 
text and large text.

Slate and SBTN Yellow 
are an accessible 
combination for small 
text and large text.

Slate and Off-white 
are an accessible 
combination for small 
text and large text.

SBTN Yellow
R:255 G:181 B:51
#ffb533 
C:0 M:35 Y:100 K:0

SBTN Dark Yellow
R:186 G:120 B:8  
#ba7808 
C:20 M:53 Y:100 K:10

DARK SBTN 
YELLOW ON 
OFF-WHITE

SLATE ON 
SBTN YELLOW

OFF-WHITE ON 
DARK SBTN 
YELLOW

SBTN YELLOW 
ON SLATE

Accessible typography color combination for large text Accessible typography color combination for small and large text

Component colors
Each component uses the Global 
Commons Alliance slate and off-white as 
core typography and background colors 
with an additional component color for 
use with typography and collages.

Tints of  the component color can be 
used in charts and infographics. A dark 
version of  each component color exists for 
accessible display typography.

Typography color rules
Refer to these typography color 
combinations for creating accessible and 
user-friendly designs. Text should have 
sufficient contrast with its background to 
be easily readable. 

Large text is defined as 14 point (typically 
18.66px) and bold or larger, or 18 point 
(typically 24px) or larger and regular.

Small text is defined as less than 14 point 
(typically 18.66px) and bold, or less than 18 
point (typically 24px) and regular.

If  a color combination is not shown here 
please avoid using it.

SCIENCE BASED TARGETS NETWORK: COLORS

Slate
Pantone: 2217u 
R:0 G:60 B:70   
#003c46 
C:100 M:45 Y:30 K:65

Off-white
R:248 G:245 B:235   
#f8f5eb 
C:0 M:1 Y:14 K:0

80% 
#ffc45c 

60%
#ffd385

40%
#ffe1ad 

20%
#fff0d6 
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A suite of  collage elements have been 
selected for each component. Positive and 
negative versions of  each element have 
been created in slate, off-white and the 
colour of  that component.

Additional collage elements can be made 
by following this guide here. Additionally, 
existing elements from other components 
or the Global Commons Alliance suite can 
be recoloured accordingly.

SCIENCE BASED TARGETS NETWORK: COLLAGE ELEMENTS
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Collage logo

EARTH HQ: POSITIVE LOGOS

Leaf logo with endorsement
Minimum width: 40mm/151px

Leaf logo

Small use leaf logo with endorsement 
Minimum width: 30mm/113px

The Accountability Accelerator collage 
logo consists of  a Hibiscus leaf, flock of  
birds, a cloud and a mother and child.

The collage logo and leaf  logo usage rules 
follow the Global Commons Alliance logo 
rules found here.

When the logos are being used within any 
Global Commons Alliance channels (such 
as the Global Commons Alliance website), 
logos without endorsements can be used. 
Logos with endorsements should be used 
when implemented anywhere else.

The Small use leaf  logo with endorsement 
should be used as an alternative to the leaf  
logo with endorsement at smaller sizes.
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Collage logo Leaf logo with endorsement

Leaf logo

Small use leaf logo with endorsement

EARTH HQ: NEGATIVE LOGOS

The colors in our negative logos have been 
inversed so they stand out against dark 
backgrounds. In all other ways the same 
rules apply as on the previous page.

87Global Commons Alliance Brand Guidelines October 2023   Version 01



Slate and Off-white 
are an accessible 
combination for small 
text and large text.

Slate and EHQ range 
are an accessible 
combination for small 
text and large text.

Slate and EHQ Orange 
are an accessible 
combination for small 
text and large text.

Slate and Off-white 
are an accessible 
combination for small 
text and large text.

EHQ Orange
R:255 G:150 B:74 
#ff964a 
C:0 M:57 Y:81 K:0

Dark EHQ Orange
R217 G:95 B:38  
#d95f26 
C:10 M:72 Y:90 K:0

DARK EHQ 
ORANGE ON 
OFF-WHITE

SLATE ON  
EHQ ORANGE

OFF-WHITE 
ON DARK EHQ 
ORANGE

EHQ ORANGE 
ON SLATE

Accessible typography color combination for large text Accessible typography color combination for small and large text

Component colors
Each component uses the Global 
Commons Alliance slate and off-white as 
core typography and background colors 
with an additional component color for 
use with typography and collages.

Tints of  the component color can be 
used in charts and infographics. A dark 
version of  each component color exists for 
accessible display typography.

Typography color rules
Refer to these typography color 
combinations for creating accessible and 
user-friendly designs. Text should have 
sufficient contrast with its background to 
be easily readable. 

Large text is defined as 14 point (typically 
18.66px) and bold or larger, or 18 point 
(typically 24px) or larger and regular.

Small text is defined as less than 14 point 
(typically 18.66px) and bold, or less than 18 
point (typically 24px) and regular.

If  a color combination is not shown here 
please avoid using it.

EARTH HQ: COLORS

Slate
Pantone: 2217u 
R:0 G:60 B:70   
#003c46 
C:100 M:45 Y:30 K:65

Off-white
R:248 G:245 B:235   
#f8f5eb 
C:0 M:1 Y:14 K:0

80% 
#ffab6e 

60%
#ffc092

40%
#ffd5b7 

20%
#ffeadb 
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A suite of  collage elements have been 
selected for each component. Positive and 
negative versions of  each element have 
been created in slate, off-white and the 
colour of  that component.

Additional collage elements can be made 
by following this guide here. Additionally, 
existing elements from other components 
or the Global Commons Alliance suite can 
be recoloured accordingly.

EARTH HQ: COLLAGE ELEMENTS

89Global Commons Alliance Brand Guidelines October 2023   Version 01



EXAMPLE DESIGNS12
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CORPORATE STATIONERY

Name of  Person
Job title or other
Company name or other
Address line one goes here
Address line two here
Address line three
City Postcode
Country

Date

Dear Sir/Madam,
Reference:

A Berorerro quunt faccabo repudis es eosam, etur, cum core provid molum anditaecus qui 
dellaces aut adis doluptaque et ute nonsendi nonem. Ed qui dersperum qui sum namusdae 
nonsed et ullabor sum fugit doluptat et re pro volorest ulparis que velecus eic temque sim qui 
dolupta tusdaere re es asperunt eseque si te consedit audipid ebitior sectiunt autecus ut velitat 
esequi verumet quiscil ius.
Bitempore voluptatum incidis es mo blaborem et acil moditia tectori onsecum inctem nos est 
endelig enihillupti doluptas ant.Hendentibus corrum harum aliaesequi ipici sam quos eum 
neceper itiaectem qui dit vid eumquia pos comnis dus vel maxime pe peratius erae dunte seres 
a apitaer atecae porecatur sequi consendi sim hil iumquae auditatio. Itae ium qui offi  citaqui 
dolumqui nit alia alignie nescipis eos doluptat.
Emperup taturio nseque seque net rectinctum il mil estiore di sum qui offi  cipiet vollupienis 
etus, consectum et aut lam et voluptas es sum net volupta voluptatur, et quia quasperi consed 
eum eum inveribus quianimagnam sus utenessequid et ab ipitiasitis mo moluptae alibuscium 
dolore lique liquisim ipsam, nonseque molupta sollum qui voluptur aut rem audignatet et 
assi omnis qui odipiet lam que re volori omnitatur sed quae comnis aut odi consed mi, ut re 
cum eationse exerum velici ad es moleseq uiderum, torporera que imolest ibeatur ratus.As ut 
laccum.
Ficimin ctotas aut latqui dit quiatur ratempo rempor aut am quosae ma voluptiatum fuga. Ut 
voloresequi aborepe rspedis doluptae nonsed ut doluptate rempori ipsae. Itas dolloria ium 
quam es ent.
Yours,
Name 
Job title

90 CHURCH STREET, FL 1, #7082, NEW YORK, NY 10008 GLOBALCOMMONSALLIANCE.ORG

GLOBALCOMMONSALLIANCE Rockefeller Philanthropy Advisors, 6 West 48th Street, 10th Floor, New York, NY 10036 globalcommonsalliance.org

NAME OF PERSON
Job Title

E Name@globalcommons.org
T +00 0000 000 000

90 CHURCH STREET, FL 1, #7082, 
NEW YORK, NY 10008

globalcommonsalliance.org

NAME OF PERSON
Job Title

E Name@globalcommons.org
T +00 0000 000 000

90 CHURCH STREET, FL 1, #7082, 
NEW YORK, NY 10008

globalcommonsalliance.org
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LONG 
PRESENTATION 
TITLE 
PRESENTATION SUB-TITLE

Presentation Date

Small indepth description for the presentation 
subject/topic

Presenter Name or Website

PRESENTATION DATE 1

HEADING SLIDE TITLE
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Curabitur 
sit amet ligula in odio dignissim posuere. Integer eu aliquam est. 
Mauris pulvinar auctor ante, eu posuere nisl sollicitudin vitae. 
Proin in lacus a arcu tristique interdum sed eget risus. Aliquam 
gravida ex nec turpis tempor dapibus. 

PRESENTATION DATE 18

LONGER SECTION DIVIDER 
OR STATEMENT 

EXTRA LONG TITLE 
HEADING
Bullet Point title:

• Bullet Point
• Bullet Point
• Bullet Point
• Bullet Point
• Bullet Point
• Bullet Point

PRESENTATION DATE 16

CREATE AN ECOSYSTEM OF PARTNERS FOR
SAFEGUARDING THE GLOBAL COMMONS

SAFEGUARDING THE
GLOBAL COMMONS

Scientifi c knowledge 
partners

Earth systems
crience
framework

Local/regional
Imolementation
partners

Demonstration+
learning re GCA
added value in cities
& landscapes

Science-based targets
set by companies &
cities

Cities and Business
connectorc

Public awareness of
planetary crises &
pressure for action
from citizens

Amplifi ers of
pressure for
action

Extend the range of expertise and engagement of global 
south

Seek new partnerships in the Global South with hands-on, 
locally grounded experience and knowledge

Mapping and engage with key accountability actors

Mobilizing business to align climate and nature 
frameworks

PRESENTATION DATE 17

SLIDE HEADING 
Sub title

Lorem ipsum dolor sit amet, consectetur adipiscing 
elit. Curabitur sit amet ligula in odio dignissim 
posuere. Integer eu aliquam est. Mauris pulvinar 
auctor ante, eu posuere nisl sollicitudin vitae. Proin in 
lacus a arcu tristique interdum sed eget risus. Aliquam 
gravida ex nec turpis tempor dapibus. 

Pellentesque quis sapien libero. Pellentesque volutpat 
justo sed est fermentum tempus quis et neque. Aenean 
nec ligula lobortis, bibendum ipsum eu, lobortis augue. 
In condimentum rhoncus ligula, a commodo ligula 
vehicula posuere. Donec fermentum tristique ante vel 
pulvinar. Mauris volutpat a nisi vel porttitor. Aliquam 
vitae dolor libero. Maecenas at velit nec dolor feugiat 
laoreet non sit amet risus. Phasellus quis erat leo. 

PRESENTATION DATE 13

PRESENTATION EXAMPLE
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ZOOM BACKGROUNDS
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PUBLICATION
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WEBSITE HOMEPAGE

WHAT'S  
COMMON  
TO US ALL
NEEDS  
ALL OF  
OUR HELP

JOIN NOW

LEARN MORE

ABOUT GLOBAL COMMONS  ALLIANCE COMPONENTS  TAKE ACTION PARTNERS NEWS RESOURCES CONTACT US 

New ideas and action to safeguard  
what’s common and precious to us all

JOIN NOW

WHAT ARE THE 
GLOBAL COMMONS?

ICE SHEETS
pushing up the oceans by 5 
metres if lost completely
READ MORE

BIODIVERSITY
Learn about the five major 
threats
READ MORE

FRESHWATER
Some 1.1 billion people 
worldwide lack access
READ MORE

FORESTS
Continue to be cut down at  
an industrial scal
READ MORE

ABOUT GLOBAL COMMONS  ALLIANCE COMPONENTS  TAKE ACTION NEWS RESOURCES CONTACT US EN

HOME    GLOBAL COMMONS    ABOUT

We need them to keep our land fertile, our oceans healthy, our air clean  
and our climate stable. From the Arctic sea ice to the Amazon rainforest,  
from critical ocean currents to our fresh water network, they support  
the health – and life – of everything on Earth. 

READ LESS
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WEBSITE

SCIENCE 
A global team of leading natural and social 
scientists pioneering a first of  its kind scientific 
framework defining safe and just boundaries for 
people and the planet.

TARGETS 
A collaboration of  global non-profits translating 
the latest interdisciplinary science into targets for 
companies and cities.

MEDIA 
Earth HQ is the megaphone, media platform and 
worldwide public mobilization hub supporting the 
work of  the Global Commons Alliance.

SYSTEMS CHANGE

Systems Change Lab monitors, learns from and 
mobilizes action toward the transformational shifts 
needed to protect both people and the planet.

ENABLING COLLECTIVE
ACTION TO ACCELERATE
SYSTEMS CHANGESAFE AND JUST 

EARTH SYSTEM 
BOUNDARIES

ABOUT GLOBAL COMMONS ALLIANCE COMPONENTS TAKE ACTION PARTNERS NEWS RESOURCES CONTACT US JOIN NOW

New research quantifies the conditions needed for 
communities and economies to thrive – and provides 
guide for leaders to operate within Earth’s finite limits.

MORE

COMPANIES

Adopt science-based targets for 
all global commons

CITIES

Adopt science-based targets for 
all global commons

MEDIA

Contact Earth HQ

MORE

MORE

MORE MORE

JOIN NOWABOUT GLOBAL COMMONS  ALLIANCE COMPONENTS  TAKE ACTION PARTNERS NEWS RESOURCES CONTACT US JOIN NOWABOUT GLOBAL COMMONS  ALLIANCE COMPONENTS  TAKE ACTION PARTNERS NEWS RESOURCES CONTACT US 
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WHOEVER  
WE ARE,  
WHEREVER  
WE ARE

we share something in common.

TO SHAPE A NATION, 
you need a government. 
To shape a planet, you need  
an alliance.

G20: ACTIONS 
SUPPORTING 
TRANSFORMATION

71%
Targets achieving 
the protection and 
restoration of  nature 
should be based on 
science.

66%
When choosing where 
to live or where to 
visit, I could be more 
attracted to cities that 
work to protect nature. 32%

It makes no difference 
to me if  the business 
supplying has set 
targets based on 
science to protect and 
restore nature.

New webinar

PUBLIC 
CONSULTATION 
WEBINAR 
20 February 2023

SOCIAL MEDIA EXAMPLES
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COMPONENT SOCIAL MEDIA EXAMPLES
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January 2024 • View email in browser

News  
31/05/2023
Earth Commission

New research quantifies the conditions needed for communities 
and economies to thrive – and provides guide for leaders to op-
erate within Earth’s finite limits.
Read more

SAFE AND JUST EARTH 
SYSTEM BOUNDARIES 
PUBLISHED IN NATURE

Where to find Global 
Commons Alliance at 
Climate Week NYC 2023
News – 07/09/2023

How we can create an 
economy that values 
nature and people first
News – 07/09/2023

Why should nature and 
people be at the heart of 
COP28?
News – 07/09/2023

NEWS
NEWSLETTER
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VIDEO GRAPHICS

Launch event
2 February 2024

NIGEL TOPPING

COLLAPSE

COLLAPSE

ABRUPT THAW

DIE OFF

CONVECTION COLLAPSE

West Antarctic Ice Sheet

Greenland Ice Sheet

Boreal Permafrost

Coral Reefs

Labrador Sea

Uk Climate Action Champion

globalcommonsalliance.org @globalcommonsalliance

“Reality muse take 
presidence over 
public relations 
for nature cannot 
be fooled”

Theoretical Physicist 
Richard Peynman

WE CAN GET
TO WORK  
RIGHT NOW
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Natasha M. Matic, Ph.D. 
Executive Director Accountability Accelerator

natasha@globalcommons.org | www.globalcommons.org
Design Centre East, 503 Harbour Ave, London SW10 0XF
Tel: +1.617.459.1833

Accountability Accelerator is part of the Global Commons Alliance
Linkedin | X | Subscribe to newsletter

Zoe Tcholak-Antitch. 
Communications Director and Special Advisor

zoe@globalcommons.org 
Design Centre East, 503 Harbour Ave, London SW10 0XF
Tel: +1.617.459.1833

globalcommons.org | Linkedin | X | Subscribe to newsletter

EMAIL SIGNATURE

The safe and just Earth Systems  
Boundaries have now been published
Click here to view now
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Join the third GCA members gathering  
to make sure we continue to  
deliver against our ambitious goals

Join the third GCA members gathering  
to make sure we continue to  
deliver against our ambitious goals

90 Church Street, Fl 1, #7082,  
New York, NY 10008

16 January 2024
18.00

16 January 2024
18.00

THIRD 
GATHERING: 
GCA 2.0

WHAT'S 
COMMON 
TO US ALL 
NEEDS 
ALL OF 
OUR HELP

EVENT INVITE
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SOCIAL MEDIA – GCA

14.11.23

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed
diam aliquip ex ea commodo consequat. 

560 Following 60,5 M Followers

Joined September 2020
GlobalCommonsAlliance.org

Post s RepliesM ediaL ikes

Global Commons Alliance
@globalcommonsalliance

Follow

 

What’s common to us all?

People Highlight
239 employees working in art and design

See all details

Non-profit Organizations - 6,859 followers 14 employees

Visit websiteFollow More

About

Home          About          Posts         Jobs          People

The Global Commons Alliance (GCA) is a g rowing coalition of scientists, philant hropists, businesses and in novators, 
inspiring new ideas and action to safeguard what’s common and precious to us all: the global commons .
Our mission is to mobilize citizens, companies, cities and countries  to accelerate systems change, and become  
better guardians of the global commons .

Lorem ipsum dolor sit amet, consectetuer

761 employees working in New York City

Lorem ipsum dolor sit amet, consectetuer

Global Commons Alliance
@globalcommonsalliance

What’s common to us all?
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SOCIAL MEDIA – ACCOUNTABILITY ACCELERATOR

14.11.23

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed
diam aliquip ex ea commodo consequat. 

560 Following 60,5 M Followers

Joined September 2020
GlobalCommonsAlliance.org

Post s RepliesM ediaL ikes

Accountability Accelerator
@accountabilityaccelerator

Follow

 

Translating commitments  
into performance.
Part of  the GLOBAL COMMONS ALLIANCE

People Highlight
239 employees working in art and design

See all details

Non-profit Organizations - 6,859 followers 14 employees

Visit websiteFollow More

About

Home          About          Posts         Jobs          People

The Global Commons Alliance (GCA) is a g rowing coalition of scientists, philant hropists, businesses and in novators, 
inspiring new ideas and action to safeguard what’s common and precious to us all: the global commons .
Our mission is to mobilize citizens, companies, cities and countries  to accelerate systems change, and become  
better guardians of the global commons .

Lorem ipsum dolor sit amet, consectetuer

761 employees working in New York City

Lorem ipsum dolor sit amet, consectetuer

Accountability Accelerator
@accountabilityaccelerator

Translating commitments  
into performance.
Part of  the GLOBAL COMMONS ALLIANCE
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14.11.23

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed
diam aliquip ex ea commodo consequat. 

560 Following 60,5 M Followers

Joined September 2020
GlobalCommonsAlliance.org

Post s RepliesM ediaL ikes

Earth Commission
@earthcommission

Follow

 

Defining safe and  
just boundaries
Part of the GLOBAL COMMONS ALLIANCE

People Highlight
239 employees working in art and design

See all details

Non-profit Organizations - 6,859 followers 14 employees

Visit websiteFollow More

About

Home          About          Posts         Jobs          People

The Global Commons Alliance (GCA) is a g rowing coalition of scientists, philant hropists, businesses and in novators, 
inspiring new ideas and action to safeguard what’s common and precious to us all: the global commons .
Our mission is to mobilize citizens, companies, cities and countries  to accelerate systems change, and become  
better guardians of the global commons .

Lorem ipsum dolor sit amet, consectetuer

761 employees working in New York City

Lorem ipsum dolor sit amet, consectetuer

Earth Commission
@earthcommission

Defining safe and just boundaries
Part of the GLOBAL COMMONS ALLIANCE

SOCIAL MEDIA – EARTH COMMISSION
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14.11.23

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed
diam aliquip ex ea commodo consequat. 

560 Following 60,5 M Followers

Joined September 2020
GlobalCommonsAlliance.org

Post s RepliesM ediaL ikes

Systems Change Lab
@systemschangelab

Follow

 

Let’s change the way we think  
about changing the world.
Part of the GLOBAL COMMONS ALLIANCE

People Highlight
239 employees working in art and design

See all details

Non-profit Organizations - 6,859 followers 14 employees

Visit websiteFollow More

About

Home          About          Posts         Jobs          People

The Global Commons Alliance (GCA) is a g rowing coalition of scientists, philant hropists, businesses and in novators, 
inspiring new ideas and action to safeguard what’s common and precious to us all: the global commons .
Our mission is to mobilize citizens, companies, cities and countries  to accelerate systems change, and become  
better guardians of the global commons .

Lorem ipsum dolor sit amet, consectetuer

761 employees working in New York City

Lorem ipsum dolor sit amet, consectetuer

Systems Change Lab
@systemschangelab

Let’s change the way we think  
about changing the world.
Part of the GLOBAL COMMONS ALLIANCE

SOCIAL MEDIA – SYSTEMS CHANGE LAB
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14.11.23

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed
diam aliquip ex ea commodo consequat. 

560 Following 60,5 M Followers

Joined September 2020
GlobalCommonsAlliance.org

Post s RepliesM ediaL ikes

Science Based Targets Network
@sciencebasedtargetsnetwork

Follow

 

Reversing nature loss  
in line with science.
Part of  the GLOBAL COMMONS ALLIANCE

People Highlight
239 employees working in art and design

See all details

Non-profit Organizations - 6,859 followers 14 employees

Visit websiteFollow More

About

Home          About          Posts         Jobs          People

The Global Commons Alliance (GCA) is a g rowing coalition of scientists, philant hropists, businesses and in novators, 
inspiring new ideas and action to safeguard what’s common and precious to us all: the global commons .
Our mission is to mobilize citizens, companies, cities and countries  to accelerate systems change, and become  
better guardians of the global commons .

Lorem ipsum dolor sit amet, consectetuer

761 employees working in New York City

Lorem ipsum dolor sit amet, consectetuer

Science Based Targets Network
@sciencebasedtargetsnetwork

Reversing nature loss in line  
with science.
Part of the GLOBAL COMMONS ALLIANCE

SOCIAL MEDIA – SCIENCE BASED TARGETS NETWORK
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THANK YOU
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